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Chapter 8. Following 
Patterns over Time

In this chapter, you will look at patterns in 
streams of verbal data that indicate how as-
pects of your data vary over time. Looking for 
patterns in time helps to define the temporal 
shape of your coded data. We will consider 
simple temporal indexes and then go on to 
look at aggregate patterns.

Time
Verbal data is inherently temporal. That is, we expect language to be ever 
changing—minute by minute in oral interactions, line by line in written in-
teractions, and minute by minute as well as line by line in electronic inter-
actions. We all recognize that topics shift in conversation, that texts change 
as they structure the reader’s experience, that what we say in an interview 
this week will be different from what we say a week from now. Surprisingly, 
however, relatively few researchers try to describe the patterns in language 
that occur over time—what Geisler has elsewhere called “temporal shape” 
(Geisler & Munger, 2001).

The neglect of time as an analytic construct in the analysis of verbal data 
may arise from the belief that the temporal shape of verbal data is unpredict-
able. The exact temporal shape of language might be thought too indirect and 
messy to be worth examining. Verbal interactions are, however, often more 
regular than might first appear. Conversations don’t bounce from topic to top-
ic without rhyme or reason, but often progress with some kind of rationale. 
Texts likewise don’t shape the reader’s experience without pattern.
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Indeed, genre conventions exist to provide a kind of routinized shape that 
can structure the reading experience and help us make sense of what we’re 
reading. For instance, despite what many students think, first person pro-
nouns (I or we) are not absent in scientific texts; but neither are they distrib-
uted evenly throughout a text. Instead, they are more normally encountered 
in the introduction when authors announce the contribution they will make 
or in the conclusion when they summarize the contribution they have made. 
Looking at a text without a sense of how it evolves temporally may leave you 
unaware of such patterns. The techniques described in this chapter will help 
you to discover underlying temporal patterns in your streams of verbal data 
and thereby better understand how the stream of language shapes human ex-
perience over time.

Indexing in Time
The simplest temporal patterns involve indexing the distribution of your cod-
ing categories across any unit by which you have segmented the data. These 
can range from the obvious units of time itself (minutes, seconds, etc.) to seg-
ments of continuous discourse (words, lines, t-units, paragraphs, etc.). We 
might, for example, index how speakers change by t-unit within a meeting.

As you saw in Chapter 7, the overall distribution of speaker contribution 
can be examined by using distribution graphs like those in Figure 7.1 that show 
us, relatively speaking, how often speakers speak. When we index this data in 
time, we take this question one step further and ask how the speakers’ contri-
butions shift segment by segment during the course of the meeting: Did all 
speakers speak consistently throughout the meeting or were there clusters of 
interaction between one or more of the participants at some times and not at 
others?

The Temporal Index
A temporal index can help us to answer questions about temporal distribu-
tion. In Figure 8.1, for example, we see movement across the four speakers, 
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Cheryl, John, Ed, and Lee, as we move across the first 180 t-units of a meet-
ing. This temporal index suggests that although interaction between John 
and Cheryl was fairly even throughout this time, contributions by Lee and 
Ed were more sporadic. Lee came in just twice and said very little; Ed came 
in five times, three for relatively short contributions, but once for an extend-
ed interaction with Cheryl and a second time for a conversation primarily 
with John. Simple temporal indices like this, then, can tell us a great deal 
more about how a phenomenon of interest, like speaker contribution, plays 
itself out over time.

Figure 8.1: A temporal index in Excel showing speaker change by t-unit.

As shown in Figure 8.1, temporal indices map two variables against 
each other. One variable is temporal, the unit of segmentation such as 
the t-unit we have used in Figure 8.1. The second variable is the cate-



282   Chapter 8

gorical dimension of the data you wish to index over time. In Figure 
8.1, this dimension is speaker contribution. Conventionally, time goes 
on the x-axis; the categorical dimensional data on the y-axis. To read a 
temporal index, then, you move from left to right through time and up 
and down across the categories of your data.

Exercise 8.1 Test Your Understanding

In Figure 8.2 and Table 8.1 (available at https://wac.colostate.edu/books/practice/
codingstreams/) you will find a temporal index of the agents that a student talked 
about during an interview about a writing project on paternalism. Use this tem-
poral index to match the phenomenon listed on the left below with one or more 
portions of the index listed on the right.

Figure 8.2: A temporal index of agency over the t-units of an interview.

https://wac.colostate.edu/books/practice/codingstreams/
https://wac.colostate.edu/books/practice/codingstreams/
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Table 8.1: A temporal index of agency over the t-units of an interview.

1. The first time during the interview 
when the student talked a lot about 
the paternalist as agent.

2. The second time during the inter-
view when the student talked a lot 
about the paternalist as agent.

3. The last time during the interview 
when the student talked a lot about 
the paternalist as agent.

4. A time when the student talked 
almost exclusively about herself as 
agent.

5. A time when the student talked not 
at all about herself as agent.

6. A period in which the student talk-
ed a great deal about agents other 
than herself or a paternalist.

a. 12-24
b. 27-48
c. 52-55
d. 52-67
e. 64-67
f. 70-109
g. 78-89
h. 106-128
i. 111-125
j. 128-141
k. 153-155
l. 164-181

For Discussion: Which of the following seems to happen more often: Mixing I as 
agent with others as agent or mixing I as agent with paternalist as agent?

Making a Temporal Index
Before you make a temporal index for your data, it is useful to consider the 
order in which you want the codes to be layered (see Excel Procedures 8.1 and 
8.2 and MAXQDA Procedures 8.1 and 8.2). In Figure 8.1, for example, we have 
placed Cheryl at the bottom of the index, John second, Ed third, and Lee at 
the top. In general, it is often best to place the most frequently-occurring cat-
egories so that they will be plotted in the lower region of the index. For exam-
ple, by placing the two most frequent speakers, Cheryl and John, in the lower 
ranges of the index in Figure 8.1, we have created a base against which we can 
more easily see the more intermittent participation of Ed and Lee.
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 Excel Procedure 8.1: Giving a Numeric Value to Codes for a 
Temporal Index in Excel

https://goo.gl/Bk9wHv

1. Assign each of the codes a numeric value, beginning with 1 for the code you want to be in the lowest 
position on the index.

2. In a copy of your worksheet, insert a new column for the numeric codes next to the coding column you 
want to track in the temporal index.

3. Copy the contents of the alphanumeric column into the new column.
4. Select the newly created column.
5. Select Edit > Find > Replace and then type the alphanumeric name of your first code under Find what: 

and the chosen numeric value under Replace with.
6. Click Replace All and then OK.
7. Repeats steps 5-6 until you have replaced all of your verbal codes with their chosen numeric values.

The newly created column should now be filled with the numeric values you have assigned to your codes as 
shown in Figure 8.3.

Figure 8.3: Assigning numeric values to categories of speaker in Excel.

https://goo.gl/Bk9wHv


Following Patterns over Time   285   

 Excel Procedure 8.2: Making & Formatting a Temporal Index in Excel

https://goo.gl/Bk9wHv

1. Select the column holding the unit 
numbering and the column holding 
your numeric coding.

2. From the Insert ribbon, insert chart as 
an X-Y (Scatter) with Lines as shown 
in Figure 8.4.

3. Using the Move Chart command on 
the Chart ribbon, move the chart to a 
new sheet, naming it appropriately. 

4. If necessary, double click on the x-axis 
and change the Maximum Bounds to 
your last data point (180 in Figure 8.1)

5. Double click the y-axis and, under 
Axis Options in the Format Axis 
pane, change the Major Unit to 1 and 
the Maximum Bounds to the number 
of categories you have (4 for Figure 
8.1).

6. Under Labels in the Format Axis pane, 
select None for the Label Position.

7. Select the graph and then grab the 
bottom right hand selection point. 
Move it right to make room for your 
code labels.

8. On the Insert ribbon, insert a text box 
on the graph using the Text dropdown 
menu as shown in Figure 8.5.

9. To label with code names, insert and 
arrange text boxes with code names 
next to the y-axis like those shown in 
Figure 8.1.

Figure 8.4: Choosing a scatterplot with the insert ribbon in 
Excel.

Figure 8.5: Inserting a text box to label lines from the chart 
with code names in Excel.

https://goo.gl/Bk9wHv
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 MAXQDA Procedure 8.1: Ordering Codes for a Temporal Index in MAXQDA

https://goo.gl/Bk9wHv

1. In the Code System window, select the code you want to be in the lowest position of your index.
2. Drag it to the end of the code list.

Figure 8.6: A temporal index in MAXQDA.

For the temporal index in Figure 8.6, we have 
dragged Cheryl to the end of the code list shown 
in Figure 8.7 in order to place it in the lowest 
position.

3. Drag the remaining codes to the positions 
you have chosen above this lowest code.

Figure 8.7: Ordering the codes in MAXQDA .

 MAXQDA Procedure 8.2: Creating a Temporal Index in MAXQDA

https://goo.gl/Bk9wHv

1. Activate the codes and document you want to place on the temporal index.
2. Chose Visual Tools > Codeline and check the option for Only for activated codes command under the 

Visual Tools menu. 

You can use the scroll bar along the bottom to move through the temporal index. The slider at the top can 
be adjusted to make the columns wider or narrower. 

3. To adjust column size, grab its right-hand boundary, and drag as desired.
4. To make the index fit the window, click on the Fit to window width icon.
5. To refresh the index after making changes in the code order, click on the Refresh icon.
6. To open the index in Excel, click on the Excel icon.
7. To save the index as a image, click on the Export icon  and choose an image format in the pop up window.

https://goo.gl/Bk9wHv
https://goo.gl/Bk9wHv
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Exploring with Temporal Indices
Temporal indices function as indices into your data, helping you first to see 
patterns over time and then to explore the underlying language. Hovering over 
any point in a temporal index in Excel will show you the x- and y-coordinates 
of the temporal point. If, for example, we hover over the point with coordi-
nates (68,3), this represents the 68th segment, which has been coded as speaker 
#3, Ed.

Temporal indices like those shown in Figures 8.1 and 8.6 can help us to 
pinpoint places that involve high periods of interactivity that involve all three 
main speakers and then return to the data to examine the nature of those in-
teractive periods. From T-Unit 23 through T-Unit 41, for example, we see a 
period in which Cheryl speaks three times, John five times, and Ed six times, 
a level of interaction that occurs nowhere else in the meeting. An examination 
of the actual language used shows that the three participants are coming to 
an agreement about a set of design features, something that would require 
the participation of all three. The temporal index has given us a quick way of 
interrogating the sequence and then delving back into the verbal data to better 
understand them.

Temporal indices can also be compared, one index to the next, to identify 
differences in the temporal shape of two or more streams of verbal data. Geis-
ler and Munger (2001), for example, compared the temporal shape of emer-
gency runs with routine and critical care patients as shown in Figure 8.8. Any 
stream of language expected to have generic shape will exhibit a particular 
temporal shape, whether it be a written text or a routine class meeting. Con-
structing and comparing temporal indices across instances of these genres can 
help you to uncover interesting variations (see Excel Procedure 8.3 and MAX-
QDA Procedure 8.3).
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Figure 8.8: Comparing the temporal shape of two 
ambulance runs (from Geisler & Munger, 2001).
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Exercise 8.2 Try It Out
Using the temporal index in Figure 8.1 or in 8.6, identify the sequence of interac-
tion that seems to follow the interesting sequence pinpointed in Figures 8.9 or 
8.11 (T-Units 23-41). How does this sequence appear to be different from the one 
that came before it?

For Discussion: If you were to retrieve the data associated with this second se-
quence, what questions would you want to try to answer using the verbal data itself?

Memo 8.1: Temporal Index
Construct a temporal index for each piece of your data across your built-in contrast. 

Note overall differences in temporal shape among them. What differences do you 
see in how they unfold over time?

Are there specific sequences that you find interesting? Explore them further by 
using the temporal indices to look at the verbal data itself.

What might you conclude from looking at your temporal indices?

https://goo.gl/Bk9wHv
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 Excel Procedure 8.3: Exploring Verbal Data with a Temporal Index in Excel

https://goo.gl/Bk9wHv

1. Using a temporal index, pinpoint a interesting sequence for further exploration.
2. Hover over the beginning and end points to retrieve their x- and y-coordinates.

In Figure 8.9, for example, we have hovered over the beginning point of our interesting sequence and re-
trieved the coordinates (23,2).

  
Figure 8.9: An interesting sequence  Figure 8.10: Marking an interesting sequence with highlighting in Excel. 
pinpointed using a temporal index  
in Excel.

3. In the spreadsheet holding the verbal data, go to the segment numbered with the first coordinate (23 
in our example).

4. To facilitate further analysis, highlight the data from this beginning point down to the segment with 
the first coordinate of the ending point (41 in our example).

Figure 8.10 shows an interesting sequence highlighted to facilitate further analysis.

https://goo.gl/Bk9wHv
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 MAXQDA Procedure 8.3: Exploring Verbal Data Associated with a 
Temporal Index in MAXQDA

https://goo.gl/Bk9wHv

1. Use the scroll bar at the bottom of the Codeline window to scroll through the temporal index to pin-
point an interesting sequence for further exploration, as shown in Figure 8.11.

Figure 8.11: An interesting sequence pinpointed with a temporal index in MAXQDA.

2. Double click on the beginning cell of the interesting sequence.
3. The associated verbal segment will appear highlighted in the Document Browser window.
4. Select the text from this segment down to the ending point of the interesting sequence.
5. Click on on the icon for Highlight Coding to mark the sequence for further examination.

Figure 8.12 shows an interesting sequence marked with Highlight Coding.

Figure 8.12: Marking an interesting sequence with highlight coding in MAXQDA.
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Aggregating in Time
Temporal indices track segment-by-segment change across coding categories 
and often provide too much detail to be useful—a real case of not being able 
to see the forest for the trees. If you find that your temporal index obscures 
the differences that your distribution analysis suggests are there, you should 
consider aggregating your data into larger units of analysis. To see more of the 
forest, that is, you might aggregate:

• turns into conversational sequences,
• t-units into topical chains,
• seconds into minutes, and so on.

You could also aggregate your stream of language using what you take to be 
significant turning points in a conversation or text. In the transcript of class-
room interactions, you might aggregate by curricular unit. In the printed text, 
you might aggregate by section.

Once your data is aggregated, you can construct an aggregate temporal 
graph like the one shown in Figure 8.13. In this graph, the number of t-units 
each speaker spoke in an aggregate are stacked one on top of the other for each 
conversational sequence. The total height of the stack shows you how much 
talk any individual aggregate exhibited. We can tell from Figure 8.13, for exam-
ple, that interaction in Conversational Sequence 19 was quite lively compared 
to the interaction in Conversational Sequence 32.

Memo 8.2:  Aggregate Unit
Examine your temporal index and your data overall. Are there larger temporal pat-
terns that could be better captured by aggregating with a larger segmenting unit? 
If you have looked at a text by t-unit, what if you looked at it section by section? 
If you have examined a semester’s worth of classroom sequences, what if you 
looked at it by curricular units? Chose an aggregate unit and document the ratio-
nale for your choice.
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Figure 8.13: An aggregate temporal graph.

Making an Aggregate Temporal Graph
Creating an aggregate temporal graph takes several steps. Begin by choos-
ing an appropriate aggregate unit and then marking its borders in your 
data. If you have been working in Excel, you will then number these new 
aggregates, get subtotals for them, and then use these subtotals to create an 
aggregate temporal graph. If you are working in MAXQDA, you will need 
to use both MAXQDA and Excel to create an aggregate temporal graph. 
Specifically, you will create a codeline in MAXQDA and then move it into 
Excel to use subtotals to create an aggregate temporal graph. Procedures 
for both are outlined in Excel Procedures 8.4 through 8.7 and MAXQDA 
Procedures 8.4 through 8.10.

https://wac.colostate.edu/books/practice/codingstreams/
https://wac.colostate.edu/books/practice/codingstreams/
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Exercise 8.3 Try It Out
The data in Table 8.2 (available at https://wac.colostate.edu/books/practice/cod-
ingstreams/) has been segmented by the second. For example, 002.36 equals 2 
minutes and 36 seconds. Aggregate the data by the minute. That is, demarcate the 
boundaries and number the minutes from 1 to 6.

Table 8.2: Data Segmented by the Second

Sequence
Time in 
Minutes

Time in 
Seconds Text Tool

1 000.00 PDA
2 000.10 Make second Palm Movie (Mar 21) PDA
3 000.13 Send Teri Pilot proposal (Mar 21) PDA
4 000.18 PDA
5 000.45 Take in leave request (Mar 26) PDA
6 000.58 PDA
7 001.01 PDA
8 001.13 email programmer (Mar 26) PDA
9 001.26 PDA
10 001.28 PDA
11 001.36 spreadsheet
12 001.39 spreadsheet
13 001.47 PDA
14 001.49 call about hotel bill [Mar23, Maint] PDA
15 002.08 PDA
16 002.17 PDA
17 002.18 PDA
18 002.19 email programmer (Mar 26) PDA
19 002.24 PDA
20 002.25 Take in leave request (Mar 26) PDA
21 002.32 PDA
22 002.34 hotel bill Off-line
23 005.27 PDA
24 005.27 call about hotel bill [Mar23, Maint] PDA
25 005.34 spreadsheet
26 005.38 PDA
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Sequence
Time in 
Minutes

Time in 
Seconds Text Tool

27 005.41 spreadsheet
28 006.33 Book Prospectus spreadsheet
29 006.49 Discipline spreadsheet
30 006.53 Book Prospectus spreadsheet

 Excel Procedure 8.4: Marking the Aggregate Borders in Excel

https://goo.gl/Bk9wHv

1. Make a copy of your original data sheet.
2. Insert a new column to the left of the original segmenting unit.
3. Locate the beginning of each aggregate unit and place a zero (0) next to it in the new column.

In Figure 8.14, for example, we placed a zero at the beginning of each aggregate. These zeroes function as 
placeholders that will be relaced by numbers in the next step.

Figure 8.14: Delimiting the aggregate units with zeroes in Excel.

https://goo.gl/Bk9wHv
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 Excel Procedure 8.5: Numbering the Aggregate Units in Excel

https://goo.gl/Bk9wHv

1. Filter the column so only the zeroes are visible.
2. In the first data cell of the new column, replace the zero with the following formula:

=MAX($A$1:AX)+1

where AX is the the name of the cell above the current cell.

Figure 8.15: Filling each aggregate unit with the new numbering in Excel.

In the worksheet shown in Figure 8.15, for example, the formula in cell A2 would be

=MAX($A$1:A1)+1

3. Drag the formula down to fill the column.
4. Remove the filter.
5. Select the column and Paste Special in place for Values only.
6. Within each aggregate unit, drag the unit number down.

The result is that each of the larger aggregate units are progressvely numbered as has been done for se-
quence 1 in Figure 8.15.

https://goo.gl/Bk9wHv
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 Excel Procedure 8.6: Subtotaling by Aggregate Unit

https://goo.gl/Bk9wHv

Excel gives us the ability to create subtotals for the data in each of our aggregate units.

1. Place your cursor anywhere in 
the data for which you want 
subtotals.

2. Click on the Subtotal icon on 
the Data ribbon.

3. As shown in Figure 8.16, In 
the field At Each change in: 
choose the column with your 
aggregate unit numbering.

4. In the field Use function: 
choose Sum.

5. Under Add subtotal to: check 
off the columns for which you 
want subtotals.

6. Click OK.

Continued . . . 

Figure 8.16: Setting up subtotals in Excel.

Figure 8.17: Subtotals inserted for the aggregate units in Excel.

https://goo.gl/Bk9wHv
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 Excel Procedure 8.6: Subtotaling by Aggregate Unit (continued)

https://goo.gl/Bk9wHv

As shown in Figure 8.17, new lines are inserted at the bottom of each aggregate, with subtotals for each of 
the coding columns.

Notice that a new area has appeared to the left of your data representing the aggregate levels.

7. To see only the aggregates, click on the Level 2 icon at the top of the level bar.

As shown in Figure 8.18, this will collapse the data, showing only the subtotals.

Figure 8.18: Collapsing the data to show only subtotals in Excel.

8. To reveal all of the data, click on the Level 3 icon at the top of the Level bar.
9. To inspect a single aggregate, click on the + sign next to the aggregate unit.

https://goo.gl/Bk9wHv
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 Excel Procedure 8.7: Making an Aggregate Temporal Graph in Excel

https://goo.gl/Bk9wHv

1. Make sure the coding columns you want to graph are in numeric form (see Excel Procedure 8.1: Giving 
a Numeric Value to Codes) and that only your aggregates are visible  (see Excel Procedure 8.6).

2. Select the values in the coding columns to be graphed. Make sure not to select the Grand Total row.

For the aggregate temporal graph shown in Figure 8.13, we selected the columns for the four speakers as 
shown in in Figure 8.19.

Figure 8.19: Selecting the data to be graphed for the aggregate temporal graph shown in Figure 8.13.

3. On the Insert tab, click on Insert Line Chart.

4. In the pop-up window, click on the 2-D Area chart.

https://goo.gl/Bk9wHv
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 MAXQDA Procedure 8.4: Marking the Aggregate Borders in MAXQDA

https://goo.gl/Bk9wHv

1. Make a copy of your 
original document.

2. Right click in the 
Coding Strip to the 
left in the Document 
Browser.

3. Select Only acti-
vated codes in the 
dialogue box as show 
in Figure 8.20.

4. Click OK.
5. Locate the beginning 

of an aggregate unit 
and drag to select 
the entire aggregate.

6. Click on one of the 
Highlight Coding 
icons.

7. Select the next ag-
gregate unit and click 
on a second High-
light Coding icon. 

8. Repeat steps 5-6 for 
the remainder of the 
data.

As shown in Figure 8.21, 
your data will now be 
highlighted by aggregate 
with alternating colors.

Figure 8.20: Showing only activated codes in MAXQDA.

Figure 8.21: Aggregate units with highlight coding in MAXQDA.

https://goo.gl/Bk9wHv
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 MAXQDA Procedure 8.5: Creating and Moving the MAXQDA codeline 
into Excel

https://goo.gl/Bk9wHv

To make an aggregate temporal graph with MAXQDA data, we need to move the codeline data into Excel 
and then create the graph there.

1. In MAXQDA, create a codeline for the data by selecting the Codeline command from the Visual Tools 
menu.

2. Leave the defaults in the dialog box and click OK.
3. Move the codeline into Excel by clicking on the Excel icon.

The codeline will now open in an Excel workbook.

 MAXQDA Procedure 8.6: Moving the MAXQDA codeline into a new 
Excel worksheet

https://goo.gl/Bk9wHv

Next we create a copy of the codeline 
data and move it into a new work-
sheet were we can reformat it in 
order to make the aggregate tempo-
ral graph.

1. Place your cursor inside the table 
and type Control-A to select it.

2. Copy the selected table and 
move to a new worksheet

3. Place your cursor in A1 and issue 
the Paste Special command 
under the Edit menu.

4. As illustrated in Figure 8.22, in the 
dialog box, select Transpose.

Figure 8.22: Transposing codeline data from MAXQDA in Excel.
 Continued . . . 

https://goo.gl/Bk9wHv 
https://goo.gl/Bk9wHv
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 MAXQDA Procedure 8.6: Moving the MAXQDA codeline into a new 
Excel worksheet (continued)

https://goo.gl/Bk9wHv

5. Click OK.
6. If you have a 

warning symbol 
next to the num-
bers in your first 
column, select 
all of the column 
values and 
choose Convert 
to Number under 
the warning 
symbol as shown 
in Figure 8.23.

Figure 8.23: Converting t-units from a MAXQDA codeline to numeric 
values in Excel.

 MAXQDA Procedure 8.7: Marking the Aggregate Borders in Excel

https://goo.gl/Bk9wHv

1. Insert a new column to the left of the original segmenting unit.
2. In the aggregate column, next to the first data point, type a zero.
3. Next to the second data point, type the following formula

=IF(OR(X3>X2,Y3>Y2),0,””)

where X is the column with your first highlight color and Y is the column with your second highlight 
color.

Continued . . . 

https://goo.gl/Bk9wHv 
https://goo.gl/Bk9wHv 
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 MAXQDA Procedure 8.7: Marking the Aggregate Borders in Excel 
(continued)

https://goo.gl/Bk9wHv

In Figure 8.24, for example, we have used the following formula to locate the beginning of the aggregates

=IF(OR(C3>C2,D3>D2),0,””)

where Column C contains the red highlight and Column D contains the blue highlight.

Figure 8.24: Marking the beginning of the highlighted aggregate units from a MAXQDA codeline.

 MAXQDA Procedure 8.8: Reformat the MAXQDA codeline in Excel

https://goo.gl/Bk9wHv

1. Filter the column so only the zeroes are visible.
2. In the first data cell of the new column, replace the zero with the following formula:

=MAX($A$1:AX)+1

where AX is the the name of the cell above the current cell.

In the worksheet shown in Figure 8.24, for example, the formula in cell A2 would be

=MAX($A$1:A1)+1

3. Drag the formula down to fill the column.
4. Remove the filter.
5. Select the column and Paste Special in place for Values only.
6. Within each aggregate unit, drag the unit number down as show in Figure 8.15.

https://goo.gl/Bk9wHv 
https://goo.gl/Bk9wHv
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 MAXQDA Procedure 8.9: Subtotaling by Aggregate Unit

https://goo.gl/Bk9wHv

1. Place your cursor anywhere in the data for which you want subtotals.
2. Click on the Subtotal icon on the Data ribbon.
3. As shown in Figure 8.16, In the field At Each change in: choose the column with your aggregate unit 

numbering.
4. In the field Use function: choose Sum.
5. Under Add subtotal to: check off the columns for which you want subtotals.
6. Click OK.

As shown in Figure 8.17, new lines are inserted at the bottom of each aggregate with subtotals for each of 
the columns chosen.

Notice that a new area has appeared to the left of your data representing the aggregate levels.

7. To see only the aggregates, click on the Level 2 icon at the top of the Level bar.

As shown in Figure 8.18, this will collapse the data, showing only the subtotals.

8. To reveal all of the data, click on the Level 3 icon at the top of the Level bar.
9. To inspect a single aggregate click on the + sign next to the aggregate unit.

 MAXQDA Procedure 8.10: Making an Aggregate Temporal Graph in 
Excel

https://goo.gl/Bk9wHv

1. Make sure that only your aggregates are visible  (see MAXQDA Procedure 8.9).
2. Select the values in the coding columns to be graphed. Make sure not to select the Grand Total row.

For Figure 8.13, we selected the columns for the four speakers as shown in in Figure 8.19.

3. On the Insert tab, click on Insert Line Chart.
4. In the pop-up window, click on the 2-D Area chart.

https://goo.gl/Bk9wHv 
https://goo.gl/Bk9wHv 
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Interpreting Aggregate Patterns
Aggregate temporal graphs like that in Figure 8.13 help you to understand the 
relative contribution of each of the coding categories to the total activity in an 
interchange. In Figure 8.13, for example, we can see that the activity starting 
roughly at Conversational Sequence 16 and continuing through Conversation-
al Sequence 28 was lively and involved all the three major participants. Inter-
action between Interchange 33 and 40, by contrast, though somewhat lively, 
took place between just Cheryl and John. Such patterns can send us back into 
the data itself to explore what was going on.

To see how aggregate temporal graphs differ from temporal indices, com-
pare the graph in Figure 8.13 with the one in Figure 8.1. Figure 8.1 does a better 
job of pinpointing the exact locations of contribution from each speaker and 
the relatively infrequency of participation by Lee and Ed. It is for this reason 
we call it an index—there is a one-to-one relationship between each point on 
the graph and each segment of the data.

The aggregate temporal graph in Figure 8.13 does a better job, however, of 
helping us to see who is interacting with whom over more extended periods 
and gives us a much better sense of the level of activity in any given period. 
All this information is, of course, very useful is pulling together a complete 
description of the way that the stream of verbal data plays itself out over time 
across the categories in your coding scheme.

Exercise 8.4 Try It Out
In Figure 8.17, you will find an aggregate temporal graph of the agents talked 
about by a student during an interview about a writing project on paternalism, 
aggregated by turn. Each turn represents the student’s response to a question by 
the interviewer. These were the six questions asked:
 • At what point did you stop today?
 • Why did you stop?
 • Can you sort of describe to me generally what you put in the introduction?
 • Can you summarize what you put in that paragraph too?
 • Can you summarize what you put in that paragraph too?
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 • Do you feel better now that you’ve gotten those first two paragraphs written?

Given the pattern of activity and attention to agency shown in Figure 8.25, what 
kinds of questions would you ask to elicit attention by a writer to agents others 
than the writer herself? What kind of questions would you ask to elicit a lot of 
discussion? What kinds seem to elicit attention only to the writer herself?

Figure 8.25: Aggregate temporal graph of the data 
shown in Figure 8.2, aggregated by turn.

For Discussion: What aspects of the verbal data are clearer in Figure 8.25 than in 
8.2? What aspects of Figure 8.2 are less clear in Figure 8.25?

Memo 8.3: Aggregate Temporal Graph
Construct a temporal aggregate graph for each piece of your data across your 
built-in contrast.

Note overall differences in temporal shape among them. What differences do you 
see in how they unfold over time?
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Are there specific sequences that you find interesting. Explore them further by 
using the temporal indices to look at the verbal data itself.

What might you conclude from looking at the temporal aggregates?
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